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2  Scope 
This document provides a detailed description of the NAOMI Engineering and 
Control GUI known as ‘TopGui’. The function of every feature of the GUI is 
described here. The document is structured in the same way as the GUI. Each ‘page’ 
has a description, with subsections to describe the function of each feature within that 
page. Some knowledge of the overall structure of the NAOMI systems is assumed. 
(Note that controls that are followed by … will bring up a separate popup window or 
menu.) 

3 Overview 
TopGui is an integrated tool to allow full control of all aspects of the NAOMI 
adaptive optics (AO) system. It is intended primarily for the use of observatory staff 
and AO experts. It is used by these staff for the routine setup and operation of 
NAOMI. An alternative tool, the ‘NAOMI Observers GUI’, is available for observers 
to script observations with NAOMI. 

3.1 The ‘Tools’ Menu: TopGui Pages (In Brief) 
At startup, TopGui shows the ‘Main’ page. All other pages are accessed via the 
‘Tools’ option on the menu bar. These additional pages are shown by expanding the 
TopGui window to double size. The window can be contracted back to the basic 
display by choosing the ‘None’ option from the tools menu. A very brief description 
of each page is given here. The details of every page are contained in section 5 below. 

3.1.1 Mirror Control Page 
Full manual control is provided of both the segmented mirror and the NAOMI fast 
steering or tip/tilt mirror. 

3.1.2 Diagnostic Page 
A large amount of diagnostic data is available on command. This page allows the user 
to select a diagnostic stream for display. The display is provided in a separate popup 
window. 

3.1.3 Realtime Page 
Many of the parameters of the C40 realtime AO system can be set from this page. The 
AO reconstructor will also eventually be controlled from this page. (Not yet 
implemented). 

3.1.4 C40 Control Page 
The state of the all of the C40 processors within the AO system is displayed here. Full 
control of the two AO control loops is provided. 

3.1.5 Wavefront Sensor Display Page 
The wavefront sensor (WFS) display is on the main page. This display can be 
controlled from the WFS display page. Various WFS tools are also provided. Note 
that direct control of the SDSU WFSs is provided on a separate page. 
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3.1.6 Status Display Page 
A colour coded summary of the status of all aspects of the system is provided here. 

3.1.7 Locks Page 
The status of all of the sequencer locks is displayed here. Locks can also be broken 
from this page. 

3.1.8 Mechanism Page 
All of the NAOMI mechanisms can be manually controlled from this page at the 
EPICS assembly level. 

3.1.9 SDSU Control Page 
Direct control of the SDSU CCD cameras is provided from this page. 

3.2 Other Menu Bar Options (In Brief) 

3.2.1 The ‘File’ Option 
Files that are relevant to any page in TopGui can be loaded and saved from here. A 
button to exit TopGui is also provided. 

3.2.2 The ‘Options’ Option 
These options are provided mainly for problem debugging and program development 
purposes. They should not normally be changed. (See The ‘Options’ Menu below for 
details). 

3.2.3 Engineering Gui Option 
Some aspects of the control of NAOMI that are NOT integrated into TopGui are 
provided by separate GUI applications launched from here. 

3.2.4 Help Option 
The version of TopGui that is running can be identified from here. 

4 Running TopGui 

4.1 Command Line Options 
To run TopGui, type TopGui & at the prompt. 
TopGui is NOT pro-active. It will not alter the state of the system unless asked to do 
so. It can therefore safely be restarted at any time. 
Several command line options are provided. These are present entirely for program 
development and debugging and should not normally be used. They are described in 
Table 1 below. (See The ‘Options’ Menu below for details). 
 

TopGui Command Line Option Effect 
-help Print help on command line options 

-noepm Start with no status read from EPM 
-verbose Start with verbose option set 

Table 1: TopGui Command Line Options 
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4.2 Displays for TopGui 
TopGui is normally run on the NAOMI visualisation console ‘navis’. It can however 
be run on most SUNs and can be displayed by most X-servers. It should be noted that 
the WFS display requires an X-server visual that supports 8 bit Pseudo Color. 
 

4.3 Resources Required 
TopGui is a client of various NAOMI servers that must be running for it to operate 
correctly. These are: 
The NAOMI sequencer (known as Sequencer2). 
The NAOMI process monitor (known as EPM2). 
These two processes normally run on ‘navis’. 
The C40 communications server (known as C40Comms). 
C40Comms runs on the NAOMI imbedded Sparc ‘aocontrol1’. 
If any of these resources is not running, a system restart must be performed using the 
NaomiRestart command at the command line of ‘navis’. This command will restart all 
NAOMI systems on both ‘navis’ and ‘aocontrol1’. 

5 Colour Code 
A set of colours is used in TopGui to represent different status conditions. The colour 
code is a slightly extended version of the standard colour code in use at the Isaac 
Newton Group of Telescopes for instrumentation software: 
 
Green:  ‘Ok’, ‘Ready for use’ or ‘Idle’. 
Pink:  A warning condition. 
Red:   An error condition. (Or an emergency stop button) 
Orange: An ‘Unknown’ status. (The EPM has no information) 
Blue:  A ‘Busy’ condition. (Generally used for mechanisms) 
Cyan:  Data has been changed and no longer represents the value in the EPM 
Cyan:  Also used to show selected elements in a mimic 

6 The Tools Menu: Details of TopGui Pages 
At startup, TopGui shows only the ‘Main’ page. All other pages are accessed via the 
‘Tools’ option on the menu bar. These additional pages are shown by expanding the 
TopGui window to double size. The various elements of each page are arranged in 
‘frames’ or outlined regions with central titles. Each element of each frame is 
described in a subsection. The title of the element is followed by its type in brackets. 

6.1 The Main Page 
The main page provides a very simple top-level set of displays and controls for 
routine operation of Naomi. This is the only page visible at start-up. Any other page 
that may be opened from the Tools menu is positioned to the right of this page. The 
layout of the Main Page is shown in Figure 1. 
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Figure 1: The Layout of the Main Page 

 

6.1.1 WFS Display (Frame) 
The topmost frame contains the main page display. This is normally used for the WFS 
display. Other displays may be selected from the ‘Main Display’ menu in the ‘Display 
Control’ frame. However, no other displays are currently implemented. 

6.1.2 Display Control (Frame) 
Some basic controls for the main page display are located here. More detailed control 
is provided on the ‘WFS Control’ page. 
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6.1.2.1 Main Display (Menu) 
This menu is used to select what is displayed in the main page display area. Currently, 
only the WFS display is implemented and this menu option should be left set to WFS. 

6.1.2.2 Continuous (Toggle) 
If this toggle is set, TopGui will continuously request diagnostics data from the AO 
system and update the WFS display. If the toggle is not set, no data will be requested 
and the display will ‘freeze’. This control is also available on the WFS Display Page 
(See Continuous (Toggle)below). 

6.1.2.3 Max (Spinbox) 
The maximum display level for all pixels in the WFS display is displayed here and 
can be changed. The level will not be used until the next set of data for display 
arrives. Thus, if ‘continuous’ is not set, the display will not change when ‘max’ is 
changed. 

6.1.3 Control (Frame) 
The AO control loop (WFS loop) can be controlled from here. More detailed status 
and control of the C40 based AO control system is provided on the ‘C40 Control’ 
page. 

6.1.3.1 Open Loop (Button) 
This button opens the AO (WFS) control loop. All AO correction will cease. 

6.1.3.2  Close Loop (Button) 
This button closes the AO (WFS) control loop and activates AO correction. 

6.1.4 Performance (Frame) 
This is a display only area. The current performance of the AO system is summarised. 
This performance value is based on the centroid data that is a part of the diagnostics 
data for the WFS display. If centroid data is not currently being requested, the 
performance data will not be updated. The performance is displayed as a value of the 
Fried parameter ‘R0’ in both arc seconds and as a coherence length in cms. The value 
is integrated over a number of frames (default 100) that can be changed from the WFS 
display page (See Seeing Frames (Spinbox) below. The current frame number is also 
displayed. 

6.1.5 Status (Frame) 
A small amount of status data is displayed here. More detailed status information is 
available on the ‘Status’ page. This can be accessed directly by pressing the ‘Show 
status Details’ button. 

6.1.5.1 Loop (Text Display) 
The current state of the AO (WFS) loop is displayed. If the loop is open, it is coloured 
pink as a warning. It is coloured green when closed. 

6.1.5.2 External Control (Text Display) 
This feature is not yet in use and should display ‘OFF’. 
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6.1.5.3 Show Status Details (Button) 
The colour of this button shows the overall status of the system. It should be green 
during astronomical observations. Pressing the button displays the full status page. If 
the status is not green, the lower level element that is causing a non-green status can 
be traced by colour coding through the full status page. 

6.1.5.4 Time now (Text Display) 
The current time is displayed. The time is the system time from the machine on which 
TopGui is running. 

6.1.5.5 Last Command (Text Display) 
A simple description of the last command sent to the NAOMI sequencer by TopGui is 
displayed here. If multiple commands were sent, the last of them is displayed. The 
time at which the command was sent is also displayed. The time is the system time 
from the machine on which TopGui is running. 

6.2 Mirror Control 
The mirror control page is displayed by selecting the ‘Mirror Control’ option from the 
‘Tools’ menu on the main menu bar. This page allows full manual control of both the 
segmented mirror and the fast tip-tilt mirror. It should NOT be used during routine 
observing. The layout of the Mirror Control Page is shown in Figure 2. 
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Figure 2: The Layout of the Mirror Control Page 

 

6.2.1 Mirror Selector (Frame) 
The mirror selector frame contains a mimic of the segmented mirror. Individual 
segments or rows or columns of the mirror may be controlled. A single element is 
selected by clicking on that element. A single row is selected by clicking on the row 
number (eg R3) on the left hand side of the mimic. A single column is selected by 
clicking on the column number (eg C4) below the mimic. All segments can be 
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selected by clicking on the Select All button at the bottom of the mimic. 
The central four obscured segments are marked in green. Information on the current 
state of the segment(s) selected, is shown in the ‘Control Selected Mirrors’ frame 
below. 

6.2.2 Control Selected Mirrors (Frame) 
This frame provides control of selected mirror elements in two different ways, along 
with control of the fast tip/tilt mirror. If any mirror actuators reach their limits, the 
relevant segment in the mimic will be coloured pink as a warning.  Which type of 
control is selected is controlled by three exclusive toggles. 

6.2.2.1 Actuators (Toggle) 
When this toggle is set, display and control of the selected mirror segment(s) is 
provided in the form of individual actuator control. Each mirror segment has 3 
actuators called A, B and C. The Control Selected Mirrors frame will appear as 
shown in Figure 3. 
 

 
Figure 3:  Actuator Control of the Deformable Mirror 

6.2.2.1.1 Actuator A, Actuator B, Actuator C (Spinboxes) 
The average value of the relevant actuator for all of the mirror segments selected is 
displayed. The values may be changed. 

6.2.2.1.2 Ave. Piston (Spinbox) 
The average piston value for all three actuators on all the mirror segments selected is 
displayed. The value may be changed. 

6.2.2.1.3 Piston Angle (Spinbox) 
If a single column or row of the mirror is selected, the overall piston angle is 
displayed in this spinbox and may be changed. 

6.2.2.2 X-Y-Piston (Toggle) 
When this toggle is set, display and control of the selected mirror segment(s) is 
provided in the form of movement in X, Y and piston. It is easier to align a segment in 
this mode since the direction of movement may be easily predicted. The Control 
Selected Mirrors frame will appear as shown in Figure 4. 
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Figure 4:  X-Y-Piston Control of the Deformable Mirror 

 

6.2.2.2.1 X (Spinbox) 
The position of the selected mirror segment(s) in the X direction is displayed and can 
be changed.  

6.2.2.2.2 Y (Spinbox) 
The position of the selected mirror segment(s) in the Y direction is displayed and can 
be changed.  

6.2.2.2.3 Piston (Spinbox) 
The average piston value of the selected mirror segment(s) is displayed and can be 
changed. 

6.2.2.2.4 Piston Angle (Spinbox) 
If a single column or row of the mirror is selected, the overall piston angle is 
displayed in this spinbox and may be changed. 

6.2.2.3 Tip/Tilt Mirror (Toggle) 
When this toggle is set, control of the fast tip/tilt mirror is available. The mirror has 2 
actuators known as X and Y. The Control Selected Mirrors frame will appear as 
shown in Figure 5. 
 

 
Figure 5:  Control of the Tip/Tilt Mirror 

 

6.2.2.3.1 TipTilt X (Spinbox) 
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The tip/tilt mirror position in the X direction is displayed and can be changed. If the 
actuator reaches its limits, the spinbox background will be coloured pink as a 
warning. 

6.2.2.3.2 TipTilt Y (Spinbox) 
The tip/tilt mirror position in the Y direction is displayed and can be changed. If the 
actuator reaches its limits, the spinbox background will be coloured pink as a 
warning. 

6.2.2.3.3 Mid Range (Button) 
This button will set both the X and Y actuators of the Tip/Tilt mirror to their mid 
range (safe) values. 

6.2.2.3.4 Zero Values (Button) 
This button will set both the X and Y actuators of the Tip/Tilt mirror to their zero 
values. 

6.2.2.4 Setup… (Button) 
This will bring up the Setup popup window. 

6.2.2.4.1 Value Increment (Spinbox) 
The increment achieved in values in spinboxes on the mirror control page by using the 
up and down arrows can be altered from here. 

6.2.2.4.2 Number of bounces. (Spinbox) 
This control should not be used. 

6.2.3 Control All Mirrors (Frame) 
The controls in this frame affect ALL of the mirror segments in the deformable 
mirror, regardless of any that may currently be selected. 

6.2.3.1 Loop (Button) 
This control should not be used. 

6.2.3.2 Hysterisis (Button) 
This button will cause an anti-hysterisis cycle to be executed on all the actuators of 
the mirror. This will take up to 10 seconds. All of the mirror segments will be moved 
rapidly many times. This is designed to reduce subsequent hysterisis effects in the 
piezo-electric actuators. This must NOT be done with the strain-gauge loop closed. 
An attempt to do so will generate an error message. 

6.2.3.3 Mid Range (Button) 
This button will drive all actuators on all mirror sections of the deformable mirror to 
their mid-range values (Normally 4096). This should be done before the mirror is 
powered off or on. This represents a ‘safe’ setting for the mirror. To check if the 
mirror is at mid-range, click the ‘Select All’ button under the mirror mimic. The mean 
actuator values should be 4096. 
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6.2.3.4 Zernikes… (Button) 
This button will bring up a popup window for adding Zernikes to the deformable 
mirror shape. 

6.2.3.4.1 Mirror Zernike Control (Frame) 
This frame contains 10 spinboxes that allow Zernikes that correspond to Sidel 
aberrations to be added to the deformable mirror shape. Entering new values will add 
a unit of the selected Zernike to the current mirror shape. 

6.2.3.4.2 Load… (Button) 
The 10 Zernike values may be loaded from file. This button will bring up a file 
selection popup window. If a file is loaded, the newly loaded Zernike values will be 
added to the mirror shape. This option is also available from the ‘File’ menu on the 
main menu bar. (See Load Zernikes… (Menu Option) below). 

6.2.3.4.3 Save as… (Button) 
The 10 Zernike values may be saved to file. This button will bring up a file selection 
popup window. The name of the file to which to save must be entered. This option is 
also available from the ‘File’ menu on the main menu bar. (See Save Zernikes as… 
(Menu Option) below). 

6.2.3.4.4 Ok (Button) 
This button will close the Mirror Zernike Control popup window. The 10 Zernike 
values will be remembered by TopGui. If TopGui is closed down, they will be lost. 

6.2.3.5 Load… (Button) 
This button will bring up a file selection popup window. A previously saved file of 
the deformable mirror shape may be re-loaded. If a file is loaded, the mirror will be 
driven to that shape. 
This facility is also available from the ‘File’ menu on the TopGui menu bar. (See 
Load DACs… (Menu Option) above). 

6.2.3.6 Save (Button) 
This button will save the current deformable mirror shape (IE The current DAC 
values) to file. The file will be given a default name based on the system date/time of 
the form: yyyymmdd-hhmm where yyyy is the year, mm is the month, dd is the day, hh 
is the hour and mm is the minute. This facility is also available from the ‘File’ menu 
on the TopGui menu bar. (See Save DACs (Menu Option) below). 

6.2.3.7 File (Text field) 
The name of the last loaded or saved deformable mirror file is displayed here.  

6.3 Diag Select Page 
This page of TopGui allows the user to select from the diagnostic data that is 
available from the C40 AO system. The data requested is actually displayed as a 
dynamic graphic by a separate application launched from this page. The controls of 
this popup graphical display application are described in section 5.3.6 below. Any 
number of these diagnostic windows may be displayed. Most of the data is related 
directly to one or more of the deformable mirror segments or associated sub-aperture 
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on the wavefront sensor. A mimic, very similar to that used for manual mirror control, 
is used to select the segments required. The layout of the Mirror Control Page is 
shown in Figure 6. 
 

 
Figure 6: The Layout of the Diagnostics Page 

 

6.3.1 Diagnostics Select (Frame) 
Data from up to 2 segments can be displayed in any one popup display. Thus 1 or 2 
segments should be selected by clicking on those segments. The selected segments 
will be coloured cyan. To de-select a segment, click on it again. If more than 2 
segments are selected, only the first 2 selected will be displayed. 

6.3.1.1 Plot Selected Segments (Button) 
When the required segments(s) have been selected, and the required data type selected 
(See Selected Segments (Frame) below), clicking on this button will bring up 
the popup graphical display. 
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6.3.2 Selected Segments (Frame) 
This frame contains a set of toggles that allow the user to select the type of diagnostic 
data required for the selected segments. These toggles are mutually exclusive. 

6.3.2.1 WFS XY Signal (Toggle) 
If this toggle is selected, data will be requested for the X and Y positions of the 
centroids of the WFS spots for the selected segments. 

6.3.2.2 DAC Values (Toggle) 
If this toggle is selected, data will be requested for the current DAC values of all 3 
actuators on each of the selected mirror segments. 

6.3.2.3 Mirror Slopes (Toggle) 
If this toggle is selected, data will be requested for the slope value of the requested 
mirror segments. 

6.3.2.4 Mirror Pistons (Toggle) 
If this toggle is selected, data will be requested for the piston values of the requested 
mirror segments. 

6.3.2.5 Strain Gauge (Toggle) 
If this toggle is selected, data will be requested for the current strain gauge values of 
all 3 actuators on each of the selected mirror segments. 

6.3.3 Average All Segments (Frame) 
Several  diagnostics may be plotted as averages over all of the mirror segments. These 
buttons will ignore any segment selection. 

6.3.3.1 WFS XY (Button) 
This will plot the average values of the X and Y positions of the WFS centroids over 
all segments. 

6.3.3.2 WFS RMS (Button) 
This will plot the RMS spread in the X and Y positions of the WFS centroids over all 
segments. 

6.3.3.3 Mirror Piston (Button) 
This will plot the average piston value of all the mirror segments. 

6.3.4 Other Diagnostics (Frame) 

6.3.4.1 FSM (Button) 
This will plot the X and Y positions of the Fast Steering Mirror (FSM). (Otherwise 
known as the Tip/Tilt mirror.) 
This is a useful plot during an observation to check that the auto-guiding offload from 
the Tip/Tilt mirror to the Telescope Control System (TCS) is functioning. 
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6.3.4.2 Seeing (Button) 
This provides a plot of seeing (as R0 in cms) based on the variance in the centroid 
positions of a selection of 4 pairs of segments. 

6.3.4.3 WFS Total Pix (Button) 
This will plot the total value of all of the light seen in all segments. 

6.3.5 Plot Control (Frame) 
How the data is required to be plotted should be set here before the plot is requested.  

6.3.5.1 Decimation (Spinbox) 
A decimation value may be set here for the diagnostic data stream. The default is for 
all the data to be sent from the C40 system; a decimation of 1. If this value is 
increased, only a subset of the data will be sent. E.G. If it is set to 5, only every fifth 
occurrence of the requested data will be sent. 

6.3.5.2 Integration (Spinbox) 
This sets the number of data values that will be displayed in ‘Oscilloscope’ mode, or 
the number of values that will be included in each point in ‘Power Spectrum’ mode. 
The default is 250. 

6.3.5.3 Mode (Menu) 
The data requested can be displayed in 1 of three different forms or modes. 

6.3.5.3.1 Oscilloscope Mode (Menu Option) 
In this mode, data will be displayed as an oscilloscope trace. However, the data is 
simply displayed as it arrives, with no attempt made to ensure that the horizontal 
(time) axis is linear. Once the number of points displayed reaches the integration 
setting (the display is full), the trace will scroll from right to left so that old data is lost 
as new data arrives. 

6.3.5.3.2 Autocorrelation (Menu Option) 
This mode operates in a similar way to the Power Spectrum mode defined below. The 
spectrum plotted is an autocorrelation of the data selected. 

6.3.5.3.3 Power Spectrum (Menu Option) 
In this mode, data will be collected in the time domain until the number of points 
reaches the integration that has been set. This may take some time, and no display is 
seen until the integration is complete. The data is then transformed to the frequency 
domain and plotted as a power spectrum with a number of points also equal to the 
integration that has been set. The spectrum will update only when a further number of 
data points equal to the integration has arrived. 

6.3.6 Graphical Diagnostics Display (Popup Window) 
All diagnostic data requested is displayed by a separate application in a graphical 
display window. The controls of this window are defined here. 
 
**** Not done yet!! **** 
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6.4 Realtime Page 
This page provides access to the realtime parameters of the AO loop and the 
reconstructor settings. The layout of the Realtime Page is shown in Figure 7. 
 

 
Figure 7: The Layout of the Realtime Page 

6.4.1 Realtime Settings (Frame) 
These controls provides access to the parameters that influence the AO loop itself 
within the C40 control system. One or more values may be changed at once. The 
spinboxes show the current values when they have a white background. Values that 
have been changed locally and not yet sent to the C40s have a cyan background. 

6.4.1.1 Loop Gain (Spinbox) 
The gain of the AO control loop , as a floating point value, can be varied via this 
spinbox. The default value at startup is 0.0. 

6.4.1.2 SegTiltLimit (Spinbox) 
The maximum amount of Tilt on the deformable mirror before it is offloaded to the 
fast steering Tip/Tilt mirror is set here. 

6.4.1.3 Pix Decim (Spinbox) 
The rate of CCD pixel data from the C40 AO loop to the C40 diagnostic CPU can be 
set here. The default value is 50 meaning that one packet in 50 is sent to the 
diagnostics system. This should not be confused with the diagnostics decimation 
system (See Decimation (Spinbox) below) that can be used to further limit the rate of 
data requested for display via the diagnostics page (Section 5.3). 

6.4.1.4 Cen Decim (Spinbox) 
The rate of WFS centroid data from the C40 AO loop to the C40 diagnostic CPU can 
be set here (See Pix Decim (Spinbox) above for details). The default value is 50. 
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6.4.1.5 TT Gain X (Spinbox) 
The gain of the Tip/Tilt fast steering mirror in the X direction can be set here. The 
default value is 0.0. 

6.4.1.6 TT Gain Y (Spinbox) 
The gain of the Tip/Tilt fast steering mirror in the Y direction can be set here. The 
default value is 0.0. 

6.4.1.7 Cancel (Button) 
Any (cyan) values that have been changed but not yet sent can be cancelled by this 
button. The values will revert to the current (white) values. 

6.4.1.8 Get Status (Button) 
The values displayed should always represent the actual values set in the C40 system. 
If for any reason they do not, this button will cause all of the current values to be read 
from the C40s and displayed. If the values are already correct, no effect will be seen. 

6.4.1.9 Apply (Button) 
When new value(s) have been entered, this button will cause all of the new values to 
be set in the C40s. If the new values fail to be set, the displays will revert to their 
previous settings and an error state should be indicated on the main page. If no values 
have been changed, this button will have no effect. 

6.4.1.10 Load (Button) 
All of the realtime settings can be saved to a file for re-loading at a later time. The 
Load button brings up a file dialogue box that displays previously saved files that can 
be loaded. When a file is loaded, the values contained in it are displayed as new 
(cyan) values but will only be sent to the C40s if the Apply button is pressed. Thus a 
file can be loaded and the values checked before they are sent or cancelled. 
Note that these files are saved at: /software/Electra/save/realtimeControl. This control 
is also available from the ‘File’ menu on the menu bar. (See Load Settings… (Menu 
Option) below). 

6.4.1.11 Save (Button) 
All of the realtime settings can be saved to a file for re-loading at a later time. The file 
will be automatically named based on the current system time as: yyyymmdd-hhmm 
where y is year, m is month, d is day, h is hour and m is minute. 
Note that these files are saved at: /software/Electra/save/realtimeControl. This control 
is also available from the ‘File’ menu on the menu bar. (See Save Settings (Menu 
Option) below). 

6.4.2 Reconstructor (Frame) 
Reconstructor control has not yet been integrated into the TopGui. An engineering 
GUI for reconstructor control can be run from the Engineering GUI button below or 
from Eng GUIs -> Reconstructor from the main menu bar. 
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6.4.2.1 Engineering GUI (Button) 
This button will launch the Reconstructor control GUI as a popup. This GUI can also 
be launched from the Eng GUIs menu on the menu bar. (See Reconstructor (Menu 
Option) below) 
 

6.5 C40 Control Page 
This page displays the status of the C40 control system and allows the user to stop or 
start the C40 rings and open or close the 2 control loops. The layout of the C40 
Control Page is shown in Figure 8. Note that the strain gauge (SG) loop being open is 
considered an error state. 

 
Figure 8: The Layout of the C40 Control Page 

 

6.5.1 C40 Status (Frame) 
The status of the C40 control system is displayed in this frame in both graphical and 
text form. 
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6.5.1.1 WFS (Label) 
This label identifies the graphic below it as a representation of the WFS C40 ring. The 
label is coloured to represent the ring status. 

6.5.1.2 1 to 9 (Buttons) 
Each button represents the C40 CPU of the same number in the WFS C40 ring. Each 
is colour coded to represent the status of that CPU. Pressing any of these will select 
that CPU to be pinged by the Ping button (See Ping (Button) below). CPU 9 at the 
centre of the ring is the diagnostics CPU. 
When the WFS ring is framing (I.E. accepting pixel data from the WFS), the 8 ring 
CPUs will be joined by lines as shown in figure 9 in which both rings are framing. 
 

 
Figure 9: C40 Status with both rings framing 

 

6.5.1.3 SG (Label) 
This label identifies the graphic below it as a representation of the SG C40 ring. The 
label is coloured to represent the ring status. Note that this label will show an error 
state if the SG loop is open. 

6.5.1.4 11 to 18 and 9 (Buttons) 
Each button represents the C40 CPU of the same number in the SG C40 ring. Each is 
colour coded to represent the status of that CPU. Pressing any of these will select that 
CPU to be Pinged by the Ping button (See Ping (Button) below). CPU 9 at the centre 
of the ring is the diagnostics CPU. 
When the SG ring is framing, the 8 ring CPUs will be joined by lines as shown in 
figure 8 in which both rings are framing. 

6.5.1.5 Diagnostics (Label) 
This label is colour coded to represent the status of the diagnostic CPU 9. 

6.5.1.6 Board (Label) 
The text string following this label reflects the status of the WFS C40 board (On left) 
or the SG C40 board (On right). 
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6.5.1.7 Framing (Label) 
The text string following this label indicates whether the WFS (On left) or SG (On 
rigt) C40 ring is framing. 

6.5.1.8 Loop State (Label) 
The text string following this label indicates whether the WFS (On left) or SG (On 
right) C40 control loop is open or closed. 

6.5.1.9 Diagnostic Board (Label) 
The text string following this label reflects the status of the Diagnostics C40 board. 

6.5.1.10 Selected CPU (Label) 
The number following this label shows which C40 CPU is currently selected. Select a 
CPU by clicking on the relevant button in the ring graphics. It is this CPU that is 
pinged by the Ping button. (See Ping (Button) below). 

6.5.1.11 Status (Label) 
The text following this label reflects the status of the currently selected C40 CPU. 

6.5.2 C40 Control (Frame) 

6.5.2.1 WFS (Label) 
This label indicates that the 6 buttons below it in this frame control the Wave Front 
Sensor C40 ring and control loop 

6.5.2.2 SG (Label) 
This label indicates that the 4 buttons below it in this frame control the Strain Gauge 
C40 ring and control loop 

6.5.2.3 Open (Button) 
If the WFS (Left) or SG loop (Right) is closed, this button will cause it to open. 

6.5.2.4 Close (Button) 
If the WFS (Left) or SG (Right) loop is open, this button will close the relevant loop. 

6.5.2.5 Start (Button) 
If the WFS C40 ring is not framing, this button will start it framing. Note that if the 
SDSU cameras are not framing, there is no pixel data available and the WFS loop will 
not start. 

6.5.2.6 Stop (Button) 
If the WFS C40 ring is framing, this button will stop it framing. 

6.5.2.7 Break Trans (Button) 
There is a small window of opportunity for commands to hang up the transaction 
system between the C40 server on aocontrol1 and the C40s themselves. If this occurs, 
all commands to that C40 ring will fail. This condition is cleared by this button for 
either the WFS or SG ring. 
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6.5.2.8 GetStatus (Button) 
The values and status displayed on this page should always represent the actual values 
set in the C40 system. If for any reason they do not, this button will cause all of the 
current values relating to either the WFS or SG ring to be read from the C40s and 
displayed. If the values are already correct, no effect will be seen. 

6.5.2.9 Ping (Button) 
This button will issue a ping to the Selected CPU (See 1 to 9 (Buttons) or 11 to 18 and 
9 (Buttons) above). The status of that CPU is updated in response to the ping. An 
error will be generated if the CPU cannot be contacted. 

6.5.2.10 GetStatus (Button) 
This button combines the function of the two GetStatus buttons described in 5.5.2.8 
above. Thus the status of both the SG and WFS rings will be updated at the same 
time. 

6.5.2.11 Emergency Stop (Button) 
This is a panic button. If a situation arises where the equipment might be in danger 
(eg the deformable mirror ‘thrashing’), this button will open all loops, and stop the 
C40s running. A full reboot will be required. 

6.5.3 C40Comms (Frame) 
C40Comms is the name of the server running on aocontrol1 that handles all 
communications between TopGui and the C40 system. This server must be running. 
The status of the server is shown in this frame. 

6.5.3.1 Host (Label) 
The text string following this label identifies the host for the C40Comms server. This 
should always be aocontrol1, the embedded Sparc in the C40 VME crate. 

6.5.3.2 Running (Label) 
The text string following this label reflects the status of the C40Comms server. This 
should normally be Up. If the status is Unknown, the status can be found using the 
Ping button (See Ping (Button) below). 

6.5.3.3 Ping (Button) 
This button will Ping the C40Comms server running on aocontrol1, and update its 
status. 

6.5.3.4 C40Comms (Label) 
This label is colour coded to reflect the status of the C40Comms server. It should 
normally be green. 

6.6 WFS Display Page 
This page controls the WFS display that appears on the main display page. The layout 
of the WFS Display Page is shown in Figure 10. A subset of these controls are 
available on the Main Display Page. (See Display Control (Frame) above). Note that 
this page controls the WFS display. The SDSU wavefront sensor cameras themselves 
are controlled from the SDSU Control page. (See SDSU Control Page below). 
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Figure 10: The Layout of the WFS Display Page 

 

6.6.1 Cursor (Frame) 
A cursor is provided to display the intensity value of any pixel within the WFS 
display. 

6.6.1.1 Cursor (Button) 
This button will switch the cursor facility on or off. The normal state is off and the 
status is displayed on the button. If the cursor is switched on, and the mouse pointer is 
positioned over the WFS display on the main page, the X and Y position of the 
selected pixel and its intensity value will be displayed on the cursor button. An X or Y 
position value of out means the mouse is outside the WFS display window. An 
intensity value of  none indicates that no intensity data is available. The cursor frame 
display will then be as shown in Figure 11. 
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Figure 11: The Cursor Display when Active 

 

6.6.2 Display Control (Frame) 
The form of the WFS display on the main page can be altered using the controls 
within this frame. 

6.6.2.1 Continuous (Toggle) 
At startup of TopGui, the WFS display will not be updated. If this toggle is set, the 
display will be updated continuously. The update rate depends on the WFS framing 
rate and on the pixel decimation rate (See Pix Decim (Spinbox) above). This control 
is also available on the Main Display Page (See Continuous (Toggle) above). 

6.6.2.2 Show Edges (Toggle) 
If this toggle is set, the boxes that represent the 8 by 8 sub-apertures of the WFS will 
be superimposed on the WFS image in red. (Note that in this version of TopGui, if the 
WFS mode is changed to other than 8 by 8 sub-apertures, the edge display remains as 
8 by 8 sub-apertures.) 

6.6.2.3 Show Centroids (Toggle) 
If this toggle is set, the latest centroid positions from the C40s will be superimposed 
as red crosses in each sub-aperture of the WFS display. 

6.6.2.4 Max (Spinbox) 
This sets the maximum of the dynamic range of the WFS display. The default value is 
2000. Any pixel with a value greater than or equal to the maximum will be displayed 
with the maximum intensity of the display. If the value is changed, it will not take 
effect until the next update occurs. This control is also available on the Main Display 
Page (See Max (Spinbox) above). 

6.6.2.5 Min (Spinbox) 
This sets the minimum of the dynamic range of the WFS display. The default value is 
zero. Any pixel with a value less than or equal to the minimum will be displayed with 
zero intensity. If the value is changed, it will not take effect until the next update 
occurs. 

6.6.2.6 Zoom (Spinbox) 
The WFS display normally shows the 8 by 8 sub-apertures of the WFS filling the 
display area (a zoom of 4). This spinbox allows the user to zoom in or out. This can 
be useful for ease of selection of a particular pixel with the cursor. If the value is 
changed, it will not take effect until the next update occurs. 

6.6.2.7 Grab (Button) 
If the Continuous toggle is not set, this button allows 1 frame of WFS data to be 
requested. (If Continuous is set, Grab has no effect). 
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6.6.3 Offsets (Frame) 
The WFS offsets are controlled from this frame. 

6.6.3.1 Get (Button) 
The WFS offsets are saved in the EPM. This button will get the current offsets from 
the C40s and update the values store in the EPM. 

6.6.3.2 Set (Button) 
This button will set the WFS offsets from the current centroids. By default, 100 
frames of centroid data will be requested from the diagnostics system and used to 
calculate the offsets. If a different number of centroids are required, this should first 
be set in the Setup menu (See Offset Frames (Spinbox) below). 

6.6.3.3 Zero (Button) 
This button will set the WFS offsets in the C40s to zero. 

6.6.3.4 Load… (Button) 
This will bring up a popup file loading dialogue box. The centroid offsets can be 
reloaded from a previously saved file (See Save (Button) below). Select an offsets file 
and click OK to load it. The saved offsets will be loaded from file and sent to the 
C40s. This option is also available from the File menu on the main menu bar. (See  
Load Offsets… (Menu Option) below). 

6.6.3.5 Save (Button) 
This will save the current offsets to file. A default filename is supplied of the form: 
yyyymmdd-hhmmss.wcnof where y is year, m is month, d is day, h is hour, m is 
minute, and s is second. The file will be saved at: 
/software/Electra/save/WFScentroidOffsets. This option is also available from the File 
menu on the menu bar. (See Save Offsets (Menu Option) below). 

6.6.3.6 File: (Label) 
The text string after this label shows the name of the last saved or loaded offsets file. 

6.6.4 Tools (Frame) 

6.6.4.1 Setup… (Button) 
This button will bring up the WFS setup popup window. 

6.6.4.1.1 Decimate (Spinbox) 
The WFS pixel and centroid data that is displayed is requested from the C40 
diagnostics system. The default decimation for this data request is 1. This can be 
changed here. Thus if a decimation of 5 is set, only every fifth set of pixel and/or 
centroid data will be requested from the diagnostics system. 

6.6.4.1.2 Offset Frames (Spinbox) 
When setting the WFS offsets from the current centroids (See Set (Button) above), the 
centroids will (by default) be averaged over 100 frames of data. This value can be 
changed here. 
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6.6.4.1.3 Seeing Frames (Spinbox) 
The seeing display on the main page (See Performance (Frame) above) is based (by 
default) on the variance in 100 frames of centroid data. This number can be changed 
here. A smaller number will lead to a more frequent update of the seeing estimate but 
with lower precision. 

6.6.4.1.4 Show Pixels (Toggle) 
When this toggle is set (by default) the WFS pixel data is requested and displayed. If 
it is unset, no pixel data will be displayed. It can be useful to see just the centroid 
crosses. 

6.6.4.2 Zernike… (Button) 
This button yields a drop down menu of 2 Zernike options. 

6.6.4.2.1 Deconvolve… (Menu Option) 
This will popup a display of the WFS data de-convolved into the 10 lowest Zernike 
modes. 

6.6.4.2.2 Offsets… (Menu Option) 
This will popup a display of spinboxes that allow any combination of the 10 lowest 
Zernike modes to be added to the WFS offsets. 
Save as and Load buttons are provided to save and re-load these values to/from file.  
These options are also available from the File menu on the Menu bar. (See WFS… 
(Menu Option) below). 

6.6.4.3 Alignment… (Button) 
This will popup the WFS alignment tool. This displays the X and Y alignment 
parameters for every frame of WFS data displayed. 

6.6.5 WFS Status (Frame) 
The status of the WFS is contained in a header on every packet of WFS pixel data 
received from the C40s. This data is extracted and displayed in this frame. Note that 
mode 1 (Full frame mode) does not currently support this feature and the data will be 
invalid in mode 1). 

6.6.5.1 WFS (Label) 
The text string after this label identifies which WFS the data is coming from (Master 
or Slave). 

6.6.5.2 Mode (Label) 
The text string after this label identifies the current mode of the WFS (from 1 to 10) 
and in brackets the sync state of the WFSs (Synched or un-synched). 

6.6.5.3 Speed (Label) 
The text string after this label identifies the current speed setting of the WFS. This can 
be slow or fast. The default setting is fast. The slow setting provides a slower readout 
with lower electron noise. 
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6.7 NAOMI Status Page 
The status of the various aspects of NAOMI are summarised on this page as a set of 
labels and buttons colour coded to represent the status of each item. (See Colour Code 
above). Clicking on the Show Status Details button on the main page (See Show 
Status Details (Button) above) will also bring up this page. Thus, if an error status is 
indicated on the main page, this page will identify in red the area in which the error 
lies and may provide further lower level details by clicking on one of the Show 
Details buttons described below. (The status indicators are hierarchical. Each status 
indicator will indicate the ‘worst’ level of status of all of the indicators in the level 
below it.) The layout of the WFS Display Page is shown in Figure 12. 
 

 
Figure 12: The Layout of the NAOMI Status Page 

 
 

6.7.1 Overall Status (Frame) 

6.7.1.1 Clear for Astronomy (Label) 
If NAOMI is in a state that is ok for astronomy, this label will be green. This is the 
status that is reflected in the colour of the Show Status Details button on the main 
page (See Show Status Details (Button) above). This indicator depends on the state of 
the four label indicators below it in this frame. 

6.7.1.1.1 Mechs Clear (Label) 
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This label will be green if the NAOMI mechanisms are all in a fit state for astronomy. 
It is dependent on both the Mechanism Status indicators (See Mechanisms Status 
(Frame) below) and on the mechanisms being in the correct position for astronomy. 

6.7.1.1.2 Acquiring (Label) 
This indicator is not yet implemented and is always green. 

6.7.1.1.3 Configuring (Label) 
This label will be green if all NAOMI mechanisms are stationary. If any is busy, the 
label will show the busy (blue) state. 

6.7.1.1.4 Error State (Label) 
This label will be green if no error has occurred in any of the NAOMI systems. For 
example, the status of the C40 Status (See Show Details (Button) below) or the 
Command Status (See Show Details (Button) below) will affect this indicator. 

6.7.2 C40 Status (Frame) 

6.7.2.1 Show Details (Button) 
The colour of this button indicates the overall status of the C40 system and is 
dependent on the state of the four label indicators below it in this frame. Pressing this 
button will bring up the C40 Status page where the status can be traced by colour to a 
lower level. 

6.7.2.2 WFS Ring (Label) 
The colour of this label indicates the overall status of the WFS C40 ring. 

6.7.2.3 SG Ring (Label) 
The colour of this label indicates the overall status of the SG C40 ring. 

6.7.2.4 Diagnostics (Label) 
The colour of this label indicates the overall status of the diagnostics C40 system. 

6.7.2.5 C40 Comms (Label) 
The colour of this label indicates the status of the C40Comms server that runs on the 
embedded Sparc aocontrol1. 

6.7.3 Command Status (Frame) 

6.7.3.1 Show Details (Button) 
The colour of this button indicates the overall status of the command system to the 
NAOMI sequencer and is dependent on the state of the four label indicators below it 
in this frame. Pressing this button will bring up a popup Command Status window. 

6.7.3.1.1 Get Status (Button) 
The command Status text area (See Status (Frame) below) is updated from the 
NAOMI EPM only when this popup is opened and when this button is pressed. 

6.7.3.1.2 Clear Errors (Button) 
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This will send a command to the NAOMI sequencer to clear the state of the error 
variables to their default values. The Status frame will continue to show the error until 
Get Status is pressed. 

6.7.3.1.3 Status (Frame) 
The text area within this frame shows the status of the variables within the NAOMI 
EPM that relate to the command system. A problem with the command system or 
with the operation of a command will change one or more of these state variables 
from its default value. The default values are as follows: 
Command Failed: False 
Exec Error:  False  (Note: This variable is no longer used) 
Warning:  None 
Error:   None 
Last output:  None 
Traceback:  None 
 
If a command knows that it has failed to execute correctly, it will set the variable 
Command Failed to True. 
If a command generates a warning message, this will be shown as the value of the 
Warning variable. 
If a command generates an error, the Error variable will contain either an error 
message from the command, or a Python traceback if the error was not handled by the 
command. 
If a command provides any output, the output is copied to the variable Last output. 
If a command crashes or fails to handle an error, a Python traceback will appear in the 
variable Traceback. 
 
Figure 13 shows the Command Status popup window with an example of Status 
information where a command error has occurred. A warning has been issued. The 
command caused an error that has not been handled and a python traceback is 
provided in the Error variable.  
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Figure 13: The Command Status Popup 

 

6.7.3.2 Show Tags (Button) 
Every command to the NAOMI sequencer has a NAOMI EPM tag associated with it. 
This tag holds the full status of the relevant command. A full description of the EPM 
tag system is beyond the scope of this manual. TopGui creates and frees tags as it 
sends commands to the NAOMI sequencer. This button brings up a popup window 
that allows access to any tags that currently exist in the EPM. Access to these tags is 
provided mainly for program development and debugging. 

6.7.3.2.1 Tag List 
The names of all outstanding tags in the EPM appear here. Tags have names of the 
form tag_nnn where nnn is a number.  

6.7.3.2.2 Tag number (Spinbox) 
To request details of a tag from the EPM, enter the number part of its name in the Tag 
number spinbox. The tag identified with a particular command can be found by 
sending the command with the Verbose option set. (See Verbose (Toggle) below). 

6.7.3.2.3 Refresh Display (Button) 
The tag details in the EPM may change at any time. This button will update the tag 
details displayed from the EPM. 

6.7.3.2.4 Tag details (Unnamed text area) 
The details of the tag are displayed in this text area. If the message ** Tag does not 
exist ** appears, the numbered tag requested has been deleted from the EPM. 

6.7.3.3 Command (Label) 
The colour of this label indicated the status of the Command Failed EPM variable. It 
is green if the value is False. 



38 

6.7.3.4 Execute (Label) 
The colour of this label indicates the status of the Exec Error EPM variable. This 
variable is no longer used and the label is permanently green. 

6.7.3.5 Warning (Label) 
The colour of this label indicates the status of the Warning EPM variable. It is green if 
the value is none. 

6.7.3.6 Error (Label) 
The colour of this label indicates the status of the Error EPM variable. It is green if 
the value is none. 

6.7.4 Mechanisms Status (Frame) 

6.7.4.1 Show Details (Button) 
The colour of this button indicates the overall status of the NAOMI mechanisms and 
is dependent on the state of the four label indicators below it in this frame. Pressing 
this button will bring up the Mechanisms page (See Mechanisms Page below) where 
the status can be traced by colour to a lower level. 

6.7.4.2 Pickoff (Label) 
The colour of this label indicates the status of the Pickoff assembly. 

6.7.4.3 ADC (Label) 
The colour of this label indicates the status of the ADC assembly. 

6.7.4.4 DM Stage (Label) 
The colour of this label indicates the status of the DM Stage assembly. 

6.7.4.5 Filters (Label) 
The colour of this label indicates the status of the Filters assembly. 

6.8 Locks Page 
The NAOMI sequencer is a parallel system that by default will execute any multiple 
commands concurrently. To prevent clashes or to enforce serial behaviour (One 
command must be done before another), a set of locks is provided. These are acquired 
and released automatically. This page is provided to show the status of the locks, and 
provide the facility to break a lock where necessary. (EG If TopGui acquires a lock 
and crashes without releasing it). DO NOT break locks unless you are sure it is safe to 
do so. Each lock entry consists of the lock name followed by its status (Acquired, 
Released or Unknown), followed by a Break Button. The layout of the locks page is 
shown in Figure 14. 
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Figure 14: The Layout of the Locks Page 

 
 

6.8.1 Tools Locks (Frame) 
The Mirror Control (Mirrors), C40 Control (C40s) and Realtime (Recon) pages have 
locks that are acquired by TopGui when the page is opened and released when it is 
closed. If a second copy of TopGui is run whilst one of these pages is open on the first 
copy, attempts to open the relevant page from the second copy will fail and cause a 
lock error. Access to these facilities is thus limited to one user at a time. 

6.8.2 Other Locks (Frame) 

6.8.2.1 Mutex (Label) 
The Mutex lock is set by commands that wish to execute when no other command is 
executing. They have exclusive use of the sequencer until they release the Mutex lock. 
This is little used in the current NAOMI system. 

6.8.2.2 External (Label) 
The External lock exists but is not yet used. 

6.8.3 Mechanism Locks (Frame) 
Each of the NAOMI mechanism assemblies, including the SDSU controllers, has a 
lock associated with it. This lock must be acquired before the relevant mechanism can 
be operated. Thus, if the Pickoff is being moved by another application, TopGui will 
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be unable to move it. An attempt to do so results in a lock error. If TopGui is already 
moving a mechanism and the user attempts to move it again, a lock error will also be 
generated. 

6.9 Mechanisms Page 
Access to NAOMI mechanisms is available from this page at the assembly level only. 
Lower level access to the NAOMI device records is provided by separate EPICS DM 
GUIs. These may be accessed from the main menu bar via Eng GUIs -> Mechanisms 
DM. These facilities are documented elsewhere. The layout of the Mechanisms page 
is shown in Figure 15. 
 

 
Figure 15: The Layout of the Mechanisms Page 

6.9.1 Pickoff (Frame) 
All controls and indicators within this frame refer to the NAOMI Pickoff assembly. 
Several values may be changed at once. The spinboxes display the current values on a 
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white background. If these values are changed, they will be shown on a cyan 
background. Hitting the Apply button will send commands to the sequencer to update 
any parameters that are marked as changed. 

6.9.1.1 X(ArcSec) (Spinbox) 
New values for the X position of the WFS pickoff mirror may be entered here as 
floating point numbers in arc seconds. 

6.9.1.2 Y(ArcSec) (Spinbox) 
New values for the Y position of the WFS pickoff mirror may be entered here as 
floating point numbers in arc seconds. 

6.9.1.3 X(mm) (Label) 
The text string following this label shows the X position of the WFS pickoff mirror in 
engineering units (mm). 

6.9.1.4 Y(mm) (Label) 
The text string following this label shows the Y position of the WFS pickoff mirror in 
engineering units (mm). 

6.9.1.5 Lenslet (Spinbox) 
The lenslet wheel may be rotated to select any of the 6 available NAOMI lenslets by 
entering a number between 1 and 6. The lenslets available are defined in Table 2. 
 

Lenslet Number Lenslet Name 
1 reticule 
2 f195_1.1 
3 doublet 
4 f95_1.1 
5 f195_1.1_offset 
6 f95_2.2 

Table 2: NAOMI Lenslets 

6.9.1.6 Name (Label) 
The text following this label is the name of the NAOMI lenslet that is currently 
selected. 

6.9.1.7 Time (Spinbox) 
A number of seconds may be entered here as the time to be taken for all motions of 
the NAOMI pickoff. The velocity will then vary depending on the size of the motion. 
This Time setting may or may not be used depending on variables set at the device 
level of the Pickoff assembly. 

6.9.1.8 Status (Label) 
The colour and value of the text string following this label reflects the status of the 
NAOMI pickoff assembly. (EG The value will be Busy on a blue background when 
the pickoff is moving). 
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6.9.1.9 Apply (Button) 
Any parameters within the Pickoff frame that have been changed (cyan background) 
will be sent to the sequencer for execution when this button is pressed. 

6.9.1.10 Offsets… (Button) 
This will bring up the Pickoff offsets popup as shown in Figure 16. Any offsets that 
are entered are added to the X and Y position of the WFS pickoff. 
 

 
Figure 16: The Pickoff Offsets Popup 

6.9.1.10.1 X(mm) (Spinbox) 
The value of the X offset can be entered here as a floating point number in mm. 

6.9.1.10.2 Y(mm) (Spinbox) 
The value of the Y offset can be entered here as a floating point number in mm. 

6.9.1.10.3 Load (Button) 
The offsets by default are zero. The current offsets file 
(/software/Electra/save/Mechanisms/Pickoff.Offsets) can be loaded by pressing this 
button. 

6.9.1.10.4 Save (Button) 
Any new offsets that are set can be saved to file by pressing this button. The values 
will be saved to: /software/Electra/save/Mechanisms/yyyymmdd-hhmm where y is 
year m is month d is day h is hour and m is minute as well as to the default file 
/software/Electra/save/Mechanisms/Pickoff.Offsets. 

6.9.1.10.5 Cancel (Button) 
If this button is pressed any new values entered in the spinboxes are cleared. 

6.9.1.10.6 Quit (Button)  
Closes the Pickoff Offsets Popup. 

6.9.1.10.7 Apply (Button) 
Any new values in the spinboxes (Cyan background) will be applied. 

6.9.1.11 Init (Button) 
This button will initialise the Pickoff Assembly EPICS record. This is only normally 
done prior to an Index (See Index (Button) below). 
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6.9.1.12 Index (Button) 
This button causes the Pickoff assembly to run through its Index cycle. An Init (See 
Init (Button) above) should normally be done first. All of the pickoff assembly 
elements, including the Lenslet wheel, will be initialised in a highly complex way. 
This can take up to 5 minutes to complete. 

6.9.2 ADC (Frame) 
The angle and offset of the NAOMI Atmospheric Dispersion Corrector can be set 
from this frame. 

6.9.2.1 Angle(Deg) (Spinbox) 
The ADC angle can be set as a floating point number of degrees in this spinbox. 

6.9.2.2 Offset(Deg) (Spinbox) 
The ADC offset angle can be set as a floating point number of degrees in this spinbox. 

6.9.2.3 Status (Label) 
The colour and value of the text string following this label reflects the status of the 
NAOMI ADC assembly. (EG The value will be Busy on a blue background when the 
pickoff is moving). 

6.9.2.4 Init (Button) 
This button will initialise the ADC  assembly EPICS record. This is only normally 
done prior to an Index (See Index (Button) below). 

6.9.2.5 Index (Button) 
This button causes the ADC assembly to run through its Index cycle. An Init (See Init 
(Button) above) should normally be done first. 

6.9.2.6 Apply (Button) 
Any parameters within the ADC frame that have been changed (cyan background) 
will be sent to the sequencer for execution when this button is pressed. 

6.9.3 DM Stage (Frame) 
The NAOMI deformable mirror X/Y stage is currently not in use. The controls in this 
frame are therefore greyed out. 

6.9.4 Calibration Unit (Frame) 
The elements of the NAOMI Calibration Unit (NCU) can be controlled from this 
frame. 

6.9.4.1 Beamsplit (Toggle) 
The Beamsplitter has only 2 states, In and Out. It should be out to select light from the 
sky for astronomy. It should be in to select light from the NCU calibration lamp. If the 
beamsplitter is in, the Mechs Clear status (See Mechs Clear (Label) above) will be a 
warning as, therefore will Clear for Astronomy (See Clear for Astronomy (Label) 
above). The BeamSplit label is followed by two further labels. The first of these is the 
state of the beamsplitter (IE In or out); the second is the colour coded status of the 
beamsplitter mechanism. 



44 

6.9.4.2 Init (Button) 
The beamsplitter has no index feature, but requires an initialisation at power up, 
provided by this button. 

6.9.4.3 Mask (Toggle) 
Light from the calibration lamp can pass through a motorised pinhole mask held in the 
NCU. This can be deployed by this toggle. It has only two states, In and Out. The 
Mask label is followed by two further labels. The first of these is the state of the mask 
(IE In or out); the second is the colour coded status of the mask mechanism. The 
pinhole mask in the maskholder can be manually changed for another mask. 

6.9.4.4 Calibration Lamp 
The various controls of the NAOMI calibration lamp are currently not active and are 
greyed out. 

6.9.5 Filters (Frame) 
NAOMI has 6 filters in a filter wheel. This mechanism is controlled from this frame. 
The filters available are shown in Table 3. 
 

Filter Number Filter Name 
1 gg_495 
2 V_wide 
3 red 
4 blank1 
5 blank2 
6 blank3 

Table 3: NAOMI Filters 

6.9.5.1 Number (Spinbox) 
A new filter is selected by entering its number in this spinbox.  

6.9.5.2 Name (Label) 
The text string after this label is the name of the currently selected filter. 

6.9.5.3 Status (Label) 
The colour and value of the text string following this label reflects the status of the 
NAOMI Filter wheel assembly. (EG The value will be Busy on a blue background 
when the pickoff is moving). 

6.9.5.4 Init (Button) 
This button will initialise the Filter assembly EPICS record. This is only normally 
done prior to an Index (See Index (Button) below). 

6.9.5.5 Index (Button) 
This button causes the Filter assembly to run through its Index cycle. An Init (See Init 
(Button) above) should normally be done first. 
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6.9.5.6 Apply (Button) 
If the filter number has been changed (cyan background) it will be sent to the 
sequencer for execution when this button is pressed. 

6.9.6 Camera Mechs (Frame) 

6.9.6.1 Power (Toggle) 
The SDSU camera power can be toggled between On and Off. 

6.9.6.2 Shutter (Toggle) 
The WFS has a shutter that can be closed to protect it from high ambient light levels. 
The shutter has too states, Open and Closed. Toggle between them with this control. 
If the shutter is closed, the Mechs Clear status (See Mechs Clear (Label) above) will 
be a warning as therefore will Clear for Astronomy (See Clear for Astronomy (Label) 
above). 

6.9.7 All Mechs (Frame) 
The controls within this frame apply to all of the mechanisms on the mechanisms 
page. 

6.9.7.1 Cancel (Button) 
If any data values have been changed (cyan background), all of them are cleared by 
pressing this button. 

6.9.7.2 GetStatus (Button) 
The values and status displayed on this page should always represent the actual 
positions and status of the mechanisms. If for any reason they do not, (EG If a low 
level EPICS GUI has been used) this button will cause all of the current values to be 
read from the EPICS system and displayed. If the values are already correct, no effect 
will be seen. 

6.9.7.3 Restart (Button) 
If the Stop all button (See Stop all (Button) below) has been used, none of the 
mechanisms can be moved until a Restart is issued by pressing this button. 

6.9.7.4 Stop all (Button) 
This is an emergency stop button for all of the NAOMI mechanisms. If it is pressed, 
any mechanism that is moving will stop. A Restart (See Restart (Button) above) must 
then be issued before any mechanisms can again be moved. Most will then require re-
initialising and indexing for correct operation. This button is coloured pink to remind 
the user not to press it except in emergencies. 

6.10 SDSU Control Page 
Control of the SDSU cameras and their associated controllers used for the WFSs in 
NAOMI was originally via EPICS. This system was abandoned and replaced by a 
terminal emulation system from this page via the NAOMI sequencer to the 
VME/VXworks system that drives the SDSUs. Note that the VXworks system can 
support only 1 login at a time. Thus any manual login to the SDSU VME crate must 
be closed for correct operation of the controls on this page. In this version of TopGui, 



46 

all commands are directed at the master SDSU. The slave SDSU is not available and 
synched modes are not supported. The layout of the SDSU Control page is shown in 
Figure 17. 
 

 
Figure 17: The Layout of the SDSU Control Page 

6.10.1 Mode (Spinbox) 
Any of the 10 modes provided by the NAOMI SDSU camera and controller can be 
selected by entering its number here. Currently, only non-synched modes are 
available. (Modes 1,2,3,8,9,10). Note that modes 1 to 7 are downloaded to the SDSU 
controller at initialisation. Modes 8 to 10 must be downloaded when they are selected. 
The latter can be quite slow and the sequencer will disable the WFS ring from 
framing whilst the new mode is downloaded. It will re-enable WFS ring framing 
when the SDSU is in the new mode. 

6.10.2 Mode name (Label) 
There is a name for each SDSU mode in TopGui. The text field to the right of this 
label is the mode name for the currently selected mode. These names are designed to 
indicate the form of the mode as shown in Table 4: 
 
Mode number Mode name Description 
1 8x8_8x8 8 by 8 sub-aperture; 8 by 8 pixels per sub-aperture 
2 8x8_2x2 8 by 8 sub-aperture; 2 by 2 pixels per sub-aperture 
3 8x8_4x4 8 by 8 sub-aperture; 4 by 4 pixels per sub-aperture 
8 4x4_4x4 4 by 4 sub-aperture; 4 by 4 pixels per sub-aperture 
9 4x4_2x2 4 by 4 sub-aperture; 2 by 2 pixels per sub-aperture 
10   

Table 4: SDSU Modes 
 

6.10.3 Sync State (Label) 
The synched modes of the NAOMI WFSs are not yet available. The text string 
following this label should always read Unsynched in all the currently available 
modes. 
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6.10.4 Status (Label) 
The colour and value of the text string following this label reflects the status of the 
SDSU camera control system. (EG The value will be Busy on a blue background 
when the SDSU control system is busy). 

6.10.5 Integration Time (Menu) 
The time for which each WFS frame is exposed can be set here. Only certain discrete 
values may be set. The current value in mille-seconds is displayed on the menu. 
Clicking on the menu brings up the available options as shown in Figure 18. 
 

 
Figure 18. The SDSU Integration Time Menu 

 
Selecting one of the menu options will send a command to the SDSU controller, via 
the NAOMI sequencer, to set that new integration time. The values actually sent to 
the controller are ‘Camera Unit’. These are indicated on the menu in brackets. 

6.10.6 Speed (Toggle) 
The WFS SDSU controller supports readout of the CCD at two different speeds. The 
default (Toggle set) is the fast readout mode. This toggle can be used to set the SDSU 
controller into the slow readout mode (Toggle reset). The readout noise of the camera 
is slightly lower in the slow readout mode. 

6.10.7 Re-Init (Button) 
At power up, the SDSU controllers must have the relevant software downloaded to 
them. This process is controlled by the sequencer. The relevant commands are sent 
when the Re-Init button is pressed. If the SDSU does not respond to normal 
commands, or appears to be in a strange state, it can be re-initialised at any time. The 
software will be downloaded and the SDSU will re-start with all the default settings. 

6.10.8 Get Status (Button) 
The values and status displayed on this page should always represent the actual values 
set in the SDSU controllers. If for any reason they do not, this button will cause all of 
the current values to be read from the SDSU controllers and displayed. If the values 
are already correct, no effect will be seen. 

6.10.9 Cancel (Button) 
A new mode number (Cyan background) can be cleared by pressing this button. 
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6.10.10 Apply (Button) 
The new mode value will be sent to the SDSU controllers when this button is pressed. 

7 The ‘File’ Menu 
All files that are relevant to the operation of TopGui can be loaded or saved from 
options within this menu. Most of these options are also available from controls on 
pages to which they are directly relevant. 

7.1 Mirror… (Menu Option) 
All files relevant to mirror control can be loaded or saved from here. 

7.1.1 Load DACs… (Menu Option) 
This option will bring up a file selector for loading a ‘Mirror flat’ that contains a 
saved mirror shape file. If a file is loaded, its contents will be loaded to the 
deformable mirror DACs. (See Load… (Button) above for details). 

7.1.2 Save DACs (Menu Option) 
This option will save the current deformable mirror shape or DAC values to file. The 
file will be given a default name based on the system date/time. (See Save (Button) 
above for details). 

7.1.3 Save DACs as… (Menu Option) 
This option will bring up a file selector for the user to select the name of the mirror 
shape or DACs file to be saved. These files are better saved with a default name (See 
Save DACs (Menu Option) above). 

7.1.4 Load Zernikes… (Menu Option) 
This option will bring up a file selection popup. The user can select a file of Zernikes 
that has previously been saved and apply them to the deformable mirror. (See Load… 
(Button) above for details). 

7.1.5 Save Zernikes as… (Menu Option) 
This option brings up a file selection popup. The user can enter the name of a file to 
which to save the current mirror Zernike values. (See Save as… (Button) above for 
details). 

7.2 Realtime… (Menu Option) 
The parameters of the C40 AO control system can be saved and loaded to/from file 
from here. 

7.2.1 Load Settings… (Menu Option) 
This option will bring up a file selector for loading ‘Realtime’ files. Note that these 
are NOT applied automatically. Open the realtime page (See Realtime Page above) 
and press apply to send the values to the C40s. (See Load (Button) above for details). 

7.2.2 Save Settings (Menu Option) 
This option will save the current realtime settings to file. The file will be given a 
default name based on the system date/time. (See Save (Button) above for details). 
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7.2.3 Save Settings as… (Menu Option) 
This option will bring up a file selector for the user to select the name of the realtime 
file to be saved. These files are better saved with a default name (See Save Settings 
(Menu Option) above). 

7.3 WFS… (Menu Option) 
Files associated with the wave front sensor can be saved and loaded from here. 

7.3.1 Load Offsets… (Menu Option) 
This option will bring up a file selector for the user to select the name of a WFS 
offsets file to be loaded. Note that the offsets will be applied as soon as the file is 
loaded. (See Load… (Button) above for details). 

7.3.2 Save Offsets (Menu Option) 
This option will save the current WFS offsets to file. The file will be given a default 
name based on the system date/time. (See Save (Button) above for details). 

7.3.3 Load Zernikes… (Menu Option) 
This option will bring up a file selector for the user to select the name of a WFS 
Zernike file to be loaded. (See Offsets… (Menu Option) above for details). 

7.3.4 Save Zernikes as… (Menu Option) 
This option will bring up a file selector for the user to select the name of a WFS 
Zernike file to be saved. (See Offsets… (Menu Option) above for details). 

8 The ‘Options’ Menu 
These options are provided mainly for debugging and program development purposes. 
They should not normally be changed. 

8.1 No EPM (Toggle) 
This toggle is not normally set. If it is set, TopGui will no longer request data from the 
NAOMI EPM state monitor. The status displayed will therefore no longer represent 
the state on the AO system. This facility is provided so that TopGui can be run for 
development or debugging when the NAOMI EPM is not running or not available. 
TopGui can be run when the EPM is unavailable by adding the flag –noepm at startup. 
This automatically sets the No EPM toggle at startup. 

8.2 No Commands (Toggle) 
This toggle is not normally set. If it is, TopGui will no longer send any commands to 
the NAOMI sequencer. Instead, a popup message will appear similar to that provided 
by the verbose option (See  below). This facility is provided so that TopGui can be 
run for development or debugging when the NAOMI Sequencer is not running or not 
available. 
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8.3 Verbose (Toggle) 
This toggle is not normally set. If it is, whenever a command is sent from TopGui to 
the NAOMI sequencer, a NAOMI message popup will appear of the type shown in 
Figure 19.  
 

 
Figure 19. NAOMI Verbose Command Example 

 
The text of the Python command sent to the sequencer is shown along with the 
returned command status and the relevant EPM command status tag name. This 
facility is useful in identifying the tag name of the command so that the tag details can 
be examined. (See Show Tags (Button) above). 

9 The ‘Eng GUIs’ Menu 
Most of the facilities required to operate NAOMI are integrated into TopGui. There 
are some lower level and calibration procedures that are not. These are available from 
separate applications. These ‘Engineering GUIs’ can be run from the options of this 
menu. 

9.1 Reconstructor (Menu Option) 
The reconstructor matrix is created and downloaded to the C40s from this application. 
It will be integrated into the Realtime page of TopGui in later versions. The GUI can 
also be launched from the Realtime page. (See Engineering GUI (Button) above). 

9.2 Fisba (Menu Option) 
The Fisba interferometer is used in the calibration procedure that involved flattening 
the deformable mirror. This required two applications to be running. The required 
software on the Fisba computer must be started manually. The ‘navis’ GUI 
application can be launched from this option. 

9.3 Ingrid Align (Menu Option) 
The GUI for performing the simplexing process with the IR camera Ingrid can be 
launched from here. 

9.4 Mechanisms DM (Menu Option) 
TopGui provides access to the NAOMI mechanism via the EPICS system only at the 
assembly record level. If access is required at the device record level or other low 
level EPICS facilities are required, the NAOMI EPICS Display Manager (DM) GUIs 
can be launched from this option. These GUIs are documented in detail elsewhere. 
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10 The ‘Help’ Menu 

10.1 About NAOMI/ELECTRA Control… (Menu Option) 
This option brings up a popup window that identifies which version of TopGui is 
running by date. 

10.2 Help… (Menu Option) 
On-line help is not available. 
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